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BAB  I 

 

PENDAHULUAN 
Desain Grafis 

 
Desain grafis adalah salah satu bentuk komunikasi visual, berupa pemilihan,kreasi, dan 

penyusunan “sesuatu” pada suatu permukaan untuk mengkomunikasikan suatu pesan. “Sesuatu” 

tersebut dapat berupa bentuk huruf (tipografi), ilustrasi ataufotografi. 

Desain grafis merupakan karya kreatif dalam banyak media, seperti media cetak, media digital, 

film, animasi, desain produk, pengepakan, dan tanda-tanda informasi. 

Komputer grafis merupakan alat yang banyak digunakan untuk membuat pekerjaan desain. 

Kemampuannya sebagai alat bantu untuk membuat animasi dan multimedia, menjadikan cakupan 

desain grafis menjadi semakin luas. 

 
Secara umum program desain grafis terdiri dari 2 macam, yaitu 

1. Berbasis vektor 

2. Berbasis bitmap (raster) 

 

Nama-nama perangkat lunak untuk desain grafis 

No. Sofware Keterangan 

1. Corel Draw Berbasis Vektor 

2. Free hand Berbasis Vektor 

3. Adobe Illustrator Berbasis Vektor 

4. Paint Berbasis Raster (bitmap) 

5. Photoshop Berbasis Raster (bitmap) 

6. Corel Photo paint Berbasis Raster (bitmap) 

7. Gimp Berbasis Raster (bitmap) 

 

Pengertian desain grafis berbasis 

Vector   : Desain grafis yang berbasis besaran dan arah, atau magnitude dan direction 

Bitmap  : Desain grafis yang memiliki berjuta-juta titik atau pixel 

 

Perbedaan desain grafis berbasis vektor dan berbasis bitmap 

Berbasis vektor Berbasis bitmap 

Gambar tetap jelas ketika diperbesar gambar kurang jelas jika di perbesar (menjadi 

kabur dan pecah) 

Tersusun oleh garis dan kurva terdiri atas titik / dot 

Ukuran file yang dihasilkan kecil ukuran file yg dihasilkan besar 

Kualitas grafik tidak bergantung dari 

banyaknya pixel 

kualitas grafis bergantung dari banyaknya pixel 
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Perbedaan dan persamaan penggunaan pewarnaan CMYK dan RGB 

 

Persamaan : 

RGB dan CMYK itu sama-sama warna primer. 

Perbedaan 

RGB CMYK 

 Red Green Blue (merah, hijau, biru) 

 RGB merupakan warna-warna primer 

yang digunakan pada monitor 

 Jadi RGB lebih digunakan untuk desain 

yang nantinya ditampilkan ke media layar 

monitor 

 Jika warna RGB di campur semua, akan 

menghasilkan warna putih 

 

 Cyan Magenta Yellow Black (orang awam 

bilang biru, merah, kuning dan hitam ) 

 CMYK merupakan warna-warna primer 

yang paling banyak digunakan pada printer 

 CMYK lebih digunakan untuk desain yang 

nantinya ditampilkan ke media cetak 

 Jika warna CMY di campur semua, akan 

menghasilkan warna hitam 

 

 

Kesimpulan : 

Untuk hasil terbaik pencetakan : 

-    Gunakan warna CMYK 

-    Kenali semua karakteristik perangkat anda (scanner, printer, monitor dll) dengan baik. 

 

Untuk desain web dan desain grafis (output monitor) 

-    Gunakan warna RGB 

-    Biasakan mengerjakan dalam ruang cahaya yang terkontrol. mengerjakan disain pada siang dan 

malam hari juga menghasilkan perbedaan warna yang berbeda (terutama untuk RGB) 

 

Istilah-istilah 

Main Menu  : Sederetan Menu yang dipersiapkan untuk membantu dalam proses   pembuatan  

dan editing gambar 

Toolbox  :    Kumpulan tool atau alat-alat yang digunakan untuk mengedit gambar 

Properties Bar  :   Tempat kita melakukan pengaturan 

Pilihan Warna / Color Pallete : Memberikan dan memberi warna pada object 

Lembar / Kertas Kerja : Tempat kita menggambar / bekerja 

Ikon  :  Lambang kecil yang berfungsi sebagai menu untuk menuju suatu fungsi. 

Menu bar  : Bar yang berisi menu 

Submenu  :  Bagian dari menu (cascading) 
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BAB  II 

 

INTERFACE CORELDRAW X3 
 

Memulai Corel 

Untuk membuka aplikasi Corel Draw X3.  
 Klik Start lalu sorot All Programs. 

 Pilih CorelDRAW Graphics Suite X3 dan Klik CorelDRAW X3. 

 

 

 

 

 

 

 

 

 

 

 

Setelah itu Biasanya muncul menu tampilan seperti berikut: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Klik new untuk membuat baru. 

 Recently used untuk membuka file-file yang telah dibuka. 

 Open untuk membuka file yang tersimpan. 

 New From Template membuat baru dari template. 

 Corel Tutor melihat instruksi secara bertahap tentang Corel Draw. 

 What’s New untuk melihat fasilitas baru pada Corel Draw X3. 

Untuk menghilangkan tampilan ini ketika membuka corel berikutnya, hilangkan tanda chek list 

pada Show this Welcome Screen at Start Up. 

 

Cara lain : Klik shortcut di desktop yang bertuliskan CorelDRAW X3. 
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Adapun untuk membuat shorcut tersebut, langkah-langkahnya: 

 Klik Start lalu sorot All Programs. 

 Pilih CorelDRAW Graphics Suite X3 dan Klik kanan (bukan klik yang kiri) CorelDRAW 

X3 

 Maka muncul sejumlah menu dan klik Send to lalu klik Desktop (Sreate Shorcut) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Apabila langkah-langkahnya benar maka icon Corel Draw X3 akan muncul. 

 

Mengenal Komponen Corel 

Berikut ini adalah tampilan jendela Corel Draw X3. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Title bar (1) berisi informasi judul aplikasi dan file yang sedang dibuka. 

 Menu bar (2) berisi menu-menu yang ada di aplikasi Corel Draw. 

1 

2 

3 

4 

5 
6 

7 

8 

9 
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 Toolbar terdiri dari beberapa icon meliputi: 

• Standar (3) perintah-perintah pada menu utama 

• Property bar (4) berisi tombol-tombol perintah tambahan. 

• Tool box (5) berisi alat untuk mendesain gambar. 

 Ruler (6) sebagai garis pengukur objek. 

 Color Pallete (7) berisi perintah untuk memilih warna objek. 

 Lembar kerja (8) halaman tampilan untuk tempat mendesain objek. 

 Pages (9) sebagai petunjuk halaman yang aktif. 

 

TOOL BOX 

Pada toolbox terdapat berbagai peralatan untuk menggambar atau membuat desain. Ikon-ikon yang 

tampil hanyalah sebagian dari yang ada. Untuk melihat ikon-ikon yang tersembunyi, klik pada ikon 

yang ada tanda segitiga. 

 

 
 

 

 

 

 

 

 

 

 

 

1.  Pick Tool : Untuk menyeleksi, mengubah ukuran, dan juga memutar arah objek gambar. 

2.  Shape Edit 

a. Shape : Menyunting bentuk objek gambar. 

b Smudge Brush : Mengubah / mendistorsi keseluruhan gambar dengan menarik garis tepinya. 

c.  Roughen Brush : Mengubah / mendistorsi keseluruhan outline bentuk gambar dengan   

menarik 

garis tepinya. 

d.  Free Transform Tools : Mengubah objek gambar menggunakan rotasi(pemutaran posisi) 

bebas, rotasi sudut, mengubah ukuran dan, dan juga memiringkan bentuk gambar. 

3.  Crop Tool 

a.   Crop : Menghilangkan bagian yang tidak diinginkan dalam objek. 

b.  Knife : Mengubah / mendistorsi keseluruhan gambar dengan menarik garis tepinya. 

c.  Erase : Menghapus area dalam gambar. 

d.  Virtual Segment Delete : Menghapus suatu bagian objek yang berada dalam 

persinggungan(interseksi). 
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4.  Zoom 

a.  Zoom : Mengubah perbesaran gambar dalam jendela gambar. 

b.  Hand : Mengatur bagian gambar yang tampil di dalam jendela gambar. 

5.  Curve 

a.  Freehand : Menggambar segmen atau kurva dalam bentuk garis tunggal. 

b.  Bezier : Menggambar kurva dalam bentuk garis tunggal per titik (node). 

c.  Artistic Media Tool : Memunculkan fungsi pembuat bentuk(pena), seperti brush(efek kuas 

dengan pola pulasan tertentu), Sprayer(efek cat semprot), Calligraphic(efek pena kaligrafi), 

dan Pressure(efek pena teknik yang akan membentuk garis tepi tanpa lengkung). 

d.  Pen : Menggambar kurva dalam sebuah segmen pertitik(node). 

e.  Polyline : Menggambar garis dan kurva dalam modus preview. 

f.  3 Point Curve : Menggambar kurva dengan menentukan titik awal dan akhir, lalu titik pusat 

kurva. 

g. Interactive Connector : Menggabungkan dua objek dengan sebuah garis. 

h. Dimension : Menggambar garis secara vertical, horizontal, bersudut, dan miring. 

6.  Smart Tools 

a.  Smart Fill : Untuk menciptakan objek dari sebuah area lalu mengisikannya dengan warna atau 

tekstur. 

b. Smart Drawing : Untuk mengubah coretan pointer yang anda gambar ke bentuk dasar atau 

bentuk yang wujudnya lebih halus. 

7.  Rectangle 

a.  Rectangle : Untuk membentuk segi dan kotak. 

b.  3 Point Rectangle : Untuk membentuk segi dan kotak dengan menyusunnya per titik. 

8. Ellipse 

a. Ellipse : Untuk menggambar elips dengan lingkaran. 

b.  Hand : Mengatur bagian gambar yang tampil di dalam jendela gambar. 

9.  Object 

a.  Polygon : Untuk membentuk polygon dan bintang secara simetris. 

b.  Star : Untuk membentuk bintang. 

c.  Complex Star : Untuk membentuk bintang dengan bentuk yang lebih kompleks dengan 

persinggungan sudut. 

d.  Graph Paper : Untuk membentuk serupa tabel atau susunan kotak-kotak seperti pada kertas 

 gambar teknik. 

e.  Spiral : Untuk membentuk spiral (per) secara simetris dan logaritmis. 

10.   Perfect Shapes 

   a. Basic Shapes : Menyediakan aneka bentuk jadi seperti segidelapan, smiley face, hingga 

  segitiga. 

   b. Arrow Shapes : Untuk memudahkan menggambar bentuk tanda panah dengan aneka variasi 

  bentuk, arah, dan jumlah kepala panah. 

  c.  Flowchart Shapes : Untuk memudahkan menggambar bentuk flowchart(bagan). 

  d.  Banner Shapes : Untuk memudahkan menggambar bentuk pita dan symbol ledakan. 

  e.  Callout : Untuk memudahkan menggambar bentuk balon bicara dan label. 

11.  Text Tool : Untuk membuat teks langsung di area gambar baik yang berfungsi sebagai teks    

artistic maupun paragraph. 

12.  Interactive Tools 

  a.  Interactive Blend : Untuk membentuk segi dan kotak 

  b.  Interactive Contour : Untuk membentuk segi dan kotak dengan menyusunnya per tit 

  c.  Interactive Distortion : Untuk mendistorsi objek secara push/pull, zipper, dan twister. 
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  d.  Interactive Drop Shadow : Untuk menyisipkan bayangan ke dalam objek. 

  e.  Interactive Envelope : Untuk mengubah bentuk objek dengan menarik titik(node) pada    

outline. 

  f.   Interactive Extrude : Untuk membentuk ilusi kedalaman pada objek. 

  g.  Interactive Transparency : Untuk menyisipkan efek transparan pada objek. 

13.  Eyedropper 

  a.  Eyedropper : Untuk menyeleksi dan menyalin property yang terkait dari sebuah objek, 

seperti warna(isi dalam objek), garis, ketebalan garis, ukuran, dan efek. 

  b. Paintbucket : Untuk menerapkan property yang terkait dari sebuah objek, seperti  

warna(isidalam objek), garis, ketebalan garis, ukuran, dan efek; yang diambil lewat 

eyedropper tool, ke objek lainnya. 

14.  Outline 

  a.  Outline Pen Dialog : Untuk mengakses boks dialog outline pen. 

  b.  Outline Color Dialog : Untuk mengakses boks dialog pengaturan warna outline. 

  c.  No Outline : Untuk menghilangkan outline dari sebuah objek. 

  d.  ½ Point Outline : Untuk membentuk ketebalan garis ½ point. 

  e.  1 Point Outline : Untuk membentuk ketebalan garis 1 point. 

  f.  2 Point Outline : Untuk membentuk ketebalan garis 2 point. 

  g. 8 Point Outline : Untuk membentuk ketebalan garis 8 point. 

  h. 16 Point Outline : Untuk membentuk ketebalan garis 16 point. 

  i.  24 Point Outline : Untuk membentuk ketebalan garis 24 point. 

  j.  Color Docker Window : Untuk membuka docker untuk pengaturan warna dan outline objek. 

15.  Fill Tools 

  a.  Fill Color Dialog : Untuk mengakses boks dialog pengaturan cat(pengisi bagian dalam 

objek) dari sebuah objek. 

  b.  Fountain Fill Dialog : Untuk mengakses boks dialog pengisi warna dan gradasi ke dalam 

   objek. 

  c.  Pattern Fill Dialog : Untuk mengakses boks dialog pengisi pola ke dalam objek. 

  d.  Texture Fill Dialog : Untuk mengakses boks dialog pengisi tekstur ke dalam objek. 

  e.  Post Script Fill Dialog : Untuk mengakses boks dialog pengisi gambar post-script ke dalam 

  objek. 

  f.   No Dialog : Untuk menghilangkan unsur pengisi dari sebuah objek. 

  g.  Color Docker Window : Untuk membuka docker untuk pengaturan warna dan outline objek. 

16.  Interactive Fill 

  a.  Interactive Fill : Untuk mengisi aneka fill(pengisi objek) ke dalam sebuah objek. 

  b.  Interactive Mesh : Untuk menerapkan garis-garis jejaring pada objek.  
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BAB  III 

 

MEMULAI CORELDRAW X3 
 

A. Membuat File Baru 

 

Untuk file  baru, langkah-langkahnya: 

  Klik menu File. 

  Lalu klik perintah New .   

  Untuk menentukan tipe kertas, klik kotak Paper Type/Size 

 

 

pada Property Bar lalu pilih jenis kertas yang anda inginkan. Misalkan letter, legal, A4, 

tabloid, dsb. 

 Jika tidak ada yang diinginkan, rubah ukuran pada paper weigh and height 

                                 Namun yang tampil disini dalam ukuran inch kita bisa  merubahnya ke  

ke Sentimeter dengan memilihnya pada Drawing Unit  

  lalu klik Centimeter. 

 

B. Menyimpan File 

Untuk menyimpan pekerjaan Corel Draw ke bentuk file, caranya: 

 Klik menu File 

 Klik Save As .  

Tentukan letak penyimpanan pada kotak Save in: 

 Lalu tulis nama filenya pada kotak filename. 

 Pada Save as type, tentukan tipe filenya. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Tekan Save. 
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C. Membuka File 

Untuk membuka file Corel Draw yang telah disimpan, caranya: 

 Klik menu File 

 Klik open   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Tentukan letak penyimpanan pada kotak Look in: 

 Lalu cari nama file pada deretan file. 

 Pada Files of type, tentukan tipe filenya. 

 Untuk melihat preview, chek list Kotak Preview. 

 Setelah file dipilih, klik Open. 

 

D. Menutup 

Untuk menutup dokumen: 

 Klik menu File 

 Klik Close .  

 

Catatan: 

Apabila muncul pertanyaan seperti berikut , itu tandanya bahwa pekerjaan yang kita kerjakan belum 

disimpan. Terdapat tiga tombol yaitu : 

 

 

 

 

 

 

 

 

 Yes untuk menyimpan dokumen/file ke file dokumen baru (jika belum disimpan 

sebelumnya) atau ke dokumen lama (jika sudah disimpan sebelumnya). Jika yang dibuka 

file dokumen lama, maka segala macam bentuk perubahan akan disimpan pada file 

dokumen tersebut. 
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 No untuk keluar dan abaikan penyimpanan 

 Cancel untuk membatalkan perintah keluar. 

 

E. Keluar dari Aplikasi Corel Draw X3 

Untuk keluar dari Corel Draw X3, 

 Klik menu File 

 Klik Exit .    

G. Menampilkan Dan Mengatur Grid 

Untuk menampilkan grid atau garis pemandu, 

 Klik menu View. 

 Lalu klik Grid. 

 Garis grid akan ditampilkan. 

Jika kita ingin mengubah garis grid menjadi titik-titik, 

 Klik menu View. 

 Grid and Ruler Setup Muncul kotak dialog, 

 

 

 

 

 

 

 

 Pilih Show grid as dots untuk mengubah garis menjadi titik-titik. 

 

H. Menambah Halaman Dalam Satu File 

 Klik Pages (halaman yang aktif) misalkan Page 1 

 Klik kanan, pilih Insert Page After. 

 

 

 

 

 

 

I. Menghapus Halaman Dalam Satu File 

 Klik Pages (halaman yang aktif) misalkan Page 2 

 Klik kanan, pilih Delete Page. 

 

 

 

 

 

 

 

 

J. Mengubah Nama Halaman Dalam Satu File 

 Klik Pages (halaman yang aktif) misalkan Page 1 

 Klik kanan, pilih Rename. 
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BAB  IV 

 

MEMBUAT BENTUK SEDERHANA 
 

A. Membuat Objek Segi Empat 

 Klik Rectangle Tool pada Tool Box       atau tekan F6 

 Pointer akan berubah menjadi tanda (+) 

 Drag dan drop mouse pada lembar kerja akan terbentuk persegi panjang. 

 Jika anda ingin membuat persegi/ bujur sangkar, Langkah sama seperti membuat persegi 

panjang. hanya saja pada saat drag tombol kiri mouse sambil tekan Ctrl pada keyboard. 
 

Jika ingin sudut dari segi empat di atas berbentuk melengkung (tidak siku) maka caranya adalah 

: 

 Tekan Pick Tool   pada Tool Box. 

 Pilih objek segi empat tersebut. 

 Klik Shape Tool   (atau tekan F10). 

 Arahkan pointer pada sudut segi empat lalu drag (geser sedikit) dengan menekan tombol kiri 

mouse. 
 

 

 

 

 

 

 

 

 

B. Membuat Objek Lingkaran 

 Klik Ellipse Tool pada Tool Box   atau tekan F7. 

 Pointer akan berubah menjadi tanda (+). 

 Drag dan drop mouse pada lembar kerja akan terbentuk lingkaran. 
 

C.  Membuat Objek Polygon 

 Klik Polygon Tool               atau tekan Y. 

 Arahkan pointer yang berbentuk (+) ke lembar kerja. 

 Tekan tombol kiri mouse geser secara diagonal sambil tekan tombol Ctrl pada  keyboard. 

 Terbentuklah polygon segi lima. 

 Untuk menambah atau mengurangi segi tersebut, gunakan fasilitas Number of Point on 

Polygon . 

 

 Klik segi yang dikehendaki (missal 6). 

 Akan terbentuk segienam. 

Untuk mengubah polygon menjadi bentuk bintang, lakukan langkah berikut. 

 Klik bentuk segi lima. 

 Tekan shape Tool   

 Arahkan pointer ke objek tersebut di antara dua segi yang berpotongan. Lalu tarik kedalam. 
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 Terbentuk segi lima menjadi bintang . 

 

D.  Membuat Objek Bintang 

 Klik dan tahan Polygon Tool .  

 Lalu klik Star Tool .   

 

 Arahkan pointer yang berbentuk (+) ke lembar kerja. 

 Tekan tombol kiri mouse geser secara diagonal sambil tekan tombol Ctrl pada keyboard. 

 Terbentuklah gambar bintang. 

 Untuk menambah atau mengurangi banyak segi dari bintang tersebut, gunakan fasilitas 

Number of Point on Polygon .   

 

 Klik segi yang dikehendaki (missal 6). 

 Akan terbentuk segienam. 
 

E.  Membuat Objek Spiral 

 Klik dan tahan Polygon Tool. 

 Pilih Spiral Tool atau tekan A .   

 Pada lembar kerja klik dan geser tombol kiri mouse sambil tekan tombol Ctrl pada 

keyboard. 

 Terbentuklah spiral. 
 

F.  Membuat Objek Table 

 Klik polygon Tool. 

 Klik Grap Paper Tool            atau tekan D. 

 Tekan dan geser tombol kiri mouse pada kanvas. 

 Terbentuklah table. 

Untuk merubah banyak tabel, rubahlah Graph Paper Colums and Rows 
 

 

 

pada kotak   isikan banyaknya kolom dan pada kotak   isikan 

banyaknya baris. 
 

G.  Membuat Objek Dengan Bentuk bervariasi 

 Klik dan tahan Basic Shapes        lalu pilih salah satu icon yang disediakan. Seperti , , , , . 
 

 

 

 

 Tentukan bentuknya pada Perfect Shapes di Property Bar seperti: 



Panduan praktikum CorelDraw X3 2011 
 

   13 

tiksman8kediri--------------------------------------------------------------------------------------------- susmix24.co.cc         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Lalu pilih bentuk yang dikehedaki 

 Pointer akan berubah menjadi tanda (+) 

 Drag dan drop mouse pada lembar kerja sehingga terbentuk gambar yang diingikan. 

H. Membuat Bentuk Sesuai Keinginan 

 Klik Freehand Tool pada Toolbox  

 Pada kanvas klik tombol kiri mouse. 

 Drag kearah yang diinginkan. 

 Jika sudah sesuai keinginan, tekan tombol Esc pada keyboard untuk mengakhiri. 

Apabila ingin melengkungkan garis, 

 Klik Shape Tool .  

 Tempatkan pointer pada garis yang ingin dilengkungkan. 

 Klik kanan mouse lalu klik pilihan To Curve .  
 

I.  Mengatur Warna Dan Garis Pinggir 

 Klik Pick Tool .  

 

 Klik objek yang akan diberi warna 

 Lalu klik kiri warna yang dikehendaki untuk memberi warna 

isi objek. 

 Klik kanan warna yang dikehendaki untuk memberi warna 

garis objek. 
 

J. Menyisipkan Objek Berbentuk Simbol 

 Klik menu Text lalu klik Insert Symbol Character atau tekan 

Ctrl + F11 di keyboard. 

 Pilih jenis font pada kotak pilihan Font: 

 Lalu Pilih Jenis karakter yang akan disisipkan pada deretan 

tampilan. 

 Tentukan ukuran karakter yang akan disisipkan pada kotak 

pilihan Character Size in. 

 Klik Insert. 
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K. Mengedit Objek 

 

1)  Menduplikat Objek 

 Klik objek menggunakan pick Tool 

 Klik menu edit lalu klik Copy 

 Untuk mengambilnya, klik lagi menu edit lalu klik Paste. 

 Atau dengan menekan tanda (+) di numlock setelah mengklik objek. 

 

2)  Merubah Ukuran Objek 

 Klik Pick Tool .  

 

 Klik objek yang akan dirubah. 

 Arahkan pointer ke salah satu node yang ada di objek dan pointer akan berubah menjadi 

panah bermata dua. 

 
 

 

 

 

 

 

 

 Tarik ke luar area objek untuk memperbesar objek atau ke dalam untuk memperkecil 

objek. 

 Atau dengan menentukan ukuran nya menggunakan Object (s) Size  

 

 atau Scale Factor         yang ada di Property Bar. 

 Tuliskan ukuran yang diinginkan dengan satuan unit (misalnya cm) untuk Object (s) 

Size atau skala dalam % untuk Scale Factor lalu tekan enter. 
 

3)  Memindahkan Objek 

 Klik Pick Tool .  

 Klik objek yang akan dipindahkan. 

 Letakkan pointer di bagian dalam objek hingga berbentuk panah bermata 4. 

 Lalu pindahkan ke tempat yang dikehendaki. 

 Klik di luar objek. 

 Atau dengan menentukan lokasi dengan menggunakan Object (s) Position   

yang ada di Property Bar. 

 Tentukan lokasi yang diinginkan lalu tekan enter. 
 

4)  Merotasikan objek 

 Klik Pick Tool .  

 Double Klik objek yang dirotasikan. 

 Tiap node akan berubah menjadi panah dua. 

 

 

 

 

 Letakkan pointer di salah satu sudut objek. 
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 Geser mouse searah jarum jam atau kebalikannya untuk merotasikan objek sampai posisi 

yang diinginkan. 

 Jika telah selesai klik mouse diluar objek. 

 Atau dengan menentukan sudut putaran menggunakan Angle Of rotatin pada Property 

Bar .  

 

 

 Tuliskan sudut untuk rotasi. 

 Tekan enter. 

 

L.  Transformasi 

1)  Menduplikasi Dengan Aturan Tertentu. 

Menduplikasi dengan aturan tertentu misalnya menduplikasi berulang-ulang untuk membuat 

deretan objek ke kanan, ke kiri ke atas atau ke bawah. Kalau menggunakan Copy-Paste pasti 

memakan waktu yang relatif lama. 

Langkah-langkahnya: 

 Klik shape tool  

 Klik objek yang akan di duplikasi. 

 Klik menu Arrange dilanjutkan dengan mengklik Transformation lalu klik Position. 

 Pastikan yang aktif bagian Position .  

 Kita bisa menduplikat menggunakan posisi pada pilihan Position: atau dengaklik  pada 

chek box di bawah Relative Position dengan posisi yang diinginka misal ke arah kanan, 

kiri, atas atau bawah.  

 

 

 

 Lalu klik Apply to Duplicate sejumlah penduplikatan yang diinginkan. 
 

 

2)  Rotasi Dengan Aturan Tertentu 

Merotasikan dengan aturan tertentu misalnya dengan merotasikan berulang-ulang, 

Langkah-langkahnya: 

 Klik shape tool       lalu klik objek yang akan di duplikat. 

 Klik menu Arrange dilanjutkan dengan mengklik Transformation lalu klik Position. 

 Pastikan yang aktif bagian Rotation .  

 Tentukan besar derajat pengrotasian pada pilihan rotation .  

 Lalu klik Apply to Duplicate sejumlah penduplikatan yang diinginkan. 

Kita bisa menggabungkan seluruh hasil duplikat dengan menyeleksi seluruh objek lalu klik 

weld         di Property Bar. 

 

M.  Menyisipkan dan mengatur teks 

Teks ada dua macam yaitu Artistik Text yaitu teks yang hanya beberapa kata dan Paragraph 

Text yaitu teks yang terdiri dari beberapa paragrap. Untuk menyisifkan teks caranya: 

 

1)  Artistik Text: 

 Klik text tool. 

 Klik saja di sembarang tempat. 

 Ketikkan teks yang diingikan. 
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2)  Paragraph Text: 

 Klik Text Tool. 

 Drag and drop selebar  text yang akan dimasukkan. 

 Ketikkan teks beberapa paragraph. 

 

Untuk Rubah posisi masing-masing karakter caranya dengan Shape Tool Drag and Drop 

masing-masing huruf. 

Untuk merubah teks menjadi Objek caranya dengan klik teks lalu klik Arrange Convert 

To Curves. 
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BAB  V 

 

PENGATURAN & PEMBENTUKAN OBJEK 

 
A.  Pembentukan 2 Objek atau lebih 

Gambarlah bentuk lingkaran, kemudian bentuk kotak menggunakan bentuk-bentuk yang 

terdapat di Tool Box, gambar kotak diberi warna, supaya proporsi gambar tidak berubah 

gambarlah sambil menekan tombol Ctrl. 

Dekatkan kedua buah gambar, kemudian pilih keduanya, dengan memblok kedua gambar 

tersebut, atau 

dengan cara klik salah satu gambar misal lingkaran, sambil menekan Shift di keyboard tekan 

gambar kotak, supaya kedua gambar terpilih. 

Jika lebih dari satu gambar yang diseleksi (dipilih) pada Property Bar akan keluar keluar 

tombol-tombol                                  yang berfungsi untuk memodifikasi gambar, cobalah 

tombol tersebut satu persatu. 

Karena yang digambar lingkaran terlebih dahulu maka gambar lingkaran ada di belakang 

(Back), gambar kotak ada didepan (Front).  

Jika ingin posisi lingkaran ada di depan, pilih lingkaran menggunakan Pick Tool     kemudian 

klik kanan Order  To Front 

Buatlah gambar-gambar sebelah kanan setelah tanda panah, seperti contoh dibawah, dan 

fahamilah 

fungsi tiap tombol. 
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Back Minus Front             : Gambar belakang dihapus oleh depan 

 

Front Minus Back             : Gambar depan dihapus oleh belakang 

 

Simplify           : Gambar depan menutupi gambar belakang 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Intersect            : Mendapatkan gambar perpotongannya 

 

Trim                  : Gambar yang diklik terlebih dahulu memotong gambar yang diklik kemudian 

 

Weld                  : Menggabungkan kedua gambar, perpotongannya hilang 

 

Combine            : Mengkombinasikan dua gambar 
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B.   Fit Text  to Path 
 

Pasilitas ini untuk membuat text atau hurup yang memiliki lengkungan. Effect ini biasa 

ditemukan pada stempel. Pada dasarnya pasilitas ini tergantung pada kemampuan Anda untuk 

membuat kurpa melengkung sebagai garis untuk menempatkan text. Untuk menjalankan 

fasilitas ini lakukan langkah-langkah dibawah ini; 
 

1. Buatlah lengkung kurpa menggunakan Curve Tool. 
 

 
 
 
 
 
 

Kurpa lengkung. 

1.  Ketik text yang Anda inginkan menggunakan artistic text 

2.  Pada posisi text terseleksi klik Text>Fit text to Path atau seperti ini  

3. Akan muncul tanda panah sebagai tanda text siap dimasukan dalam kurpa lengkung 

 
 

 
 
 
 
 

Tanda panah sebagai indikasi text siap dimasukan dalam kurpa. 

 

4. Jika Anda kurang tepat mengarahkan panah kurpa atau kurpa telalu kecil maka akan muncul 

kotak dialog yang menginformasikan bahwa bidikan anda tidak mengenai sasaran. Klik Yes 

untuk mencoba kembali. 
 
 
 
 
 
 
 

Konfirmasi untuk mengulangi. 
 

5. Hasilnya seperti gambar dibawah ini 
 
 
 
 

Text telah masuk pada kurpa. 
 

6. Pada property bar lakukan penyetingan pada Text Orientation, Vertical Placment Dan 

Text Palcement. Peroperty bar ini akan tampil ketika objek text masuk dalam kurpa. 
 
 
 
 

Property bar Text on Curve. 
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7. Anda juga dapat menghilangkan lengkungan kurpa. Klik Outline pada Flayout outline pilih 

No Outline. 
 
 
 
 
 
 
 

Setelah garis disembunyikan. 
 
 
 

C.  POWERCLIP 
Pada dasarnya PowerClip bekerja dengan menempatkan objek (PowerClip Object) dalam objek 

lain yang disebut dengan Container. Anda dapat melakukan proses editing pada PowerClip 

Object, termasuk mengeluarkan powerClip Object dari containernya. 
 

Membuat Efek PowerClip 
Unuk membuat PowerClip lakukan langkah-langkah dibwah ini; 

1. Buatklah dua objek. Tentukan mana yang akan menjadi PowerClip Object dan mana yang 

akan menjadi Container. 

2. Klik/seleksi PowerClip Objek. 

3. Klik Effect>PowerClip>Place Inside Container 

4. Klik Container. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Object yang telah dimasukan dalam container PowerClip. 
 

Mengcopy PowerClip 

Anda juga dapat melakukan proses pengopyan powerClip pada objek lain. Untuk melakukan proses 

pengcopian powerClip lakukan langkah-langkah dibawah ini; 

1. Klik Object yang akan diberi efek powerclip. 

2. Klik Effect>Copy Effect>PowerClip From… 

3. Klik Objek yang akan diberi efek PowerClip. 
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Mengedit PowerClip 

Untuk melakukan proses pengeditan PowerClip lakukan langkah-langkah dibawah ini; 

1.  Klik Objek Container. 

2.  Klik Effect>PowerClip>Edit Contain 

3.  Anda akan dibawa pada sebuah tampilan area kerja Editing Powerclip. Disini Objek Contain 

akan ditampilkan utuh. 

4. Klik Effect>PowerClip>Finish Editing this level. Anda dapat menekan tombol Finish 

Editing Symbol. 

Anda dapat melakukan pengeditan PowerClip dengan menekan Ctrl + Drag. Shotcut Key ini 

dapat digunakan ketika Anda memulai pengeditan atau ketika mengakhiri proses editing. 

 

Memecah PowerClip Object 

Anda juga dapat melakukan proses pemisahan object contain dengan containernya seperti sedia 

kala. Untuk melakukan proses ini lakukan langkah-langkah dibawah ini; 

1.  Klik Objek yang telah diberi efek PowerClip. 

2.  Klik Effect>PowerClip>Extract Contents 

3.  Kini Objek terpisah menjadi dua bagian seperti sedia kala. 
 

 

D.  PERSPECTIVE 
Pasilitas ini akan menimbulkan efek sebuah objek nampak berbentuk 3 dimensi.  

Untuk mempraktekan efek ini ada beberapa hal yang harus anda pahami sebelumnya; 

1. One-Point Perspective. Efek yang ditentukan dari satu arah point perspective. 

2. Two-Point Perspective. Efek yang ditentukan dari dua arah point perspective. 

3. Vanishing Point. Adalah tanda yang muncul ketika anda melakukan proses perspective, 

Vanishing point biasanya bertanda X ditengah objek. 

Untuk melakukan proses desain Anda menggunakan Shape Tool. Semua efek Perspective 

dapat diterapkan dalam semua object, keculai Paragraph Text, Bitmap dan Symbol. 

 

Membuat Efek Perspective 

Untuk membuat efek perspective dalam sebuah objek, lakukan langkah-langkah dibawah ini; 

1. Pilih objek yang akan diberi efek perspective. 

2. Klik Effect>Perspective. 

3. Klik Shape Tool 

4. Lakukan proses penyetingan menggunakan Shape Tool. 
 
 
 
 
 
 
 
 

Prespective pada obejct artistic text. 
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Mengcopy Perspective 

Anda bisa melakukan proses pengcopyian pada objek yang telah diberi efek perspective. Untuk 

melakukan proses pengocopiyan lakukan langkah-langkah dibawah ini; 

1. Pilih Object yang akan diberi efek perspective. 

2. Klik Effect>Copy Effect>Perspective From.. 

3. Klik pada objek yang telah diberi efek perspective. 

 
 
 
 
 
 
 
 
 

Mengcopy efek prespective. 
 

 

E.  CONTOUR 
Interactive Contour Tool  
Tool ini digunakan untuk membuat efek garis-garis kontur pada objek (shapes/text). Tahapan 

yang perlu kita siapkan : 
 
 
 

 

 

 

 

Tahap 1. Klik interactive tool pada toolbox, tahan beberapa saat untuk mengeluarkan  

flyout interactive tool yang tersedia 
 

 

      Tahap 2. Pilih interactive Contour Tool 

 

 
Interaktive Contour Tool 

 

 

Tahap 3. Aktifkan Window > Dockers > Contour atau Ctrl+F9 pada keyboard  

 

 

          Window Dockers 
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Langkah untuk menggunakan Interactive Contour Tool adalah :  

1. Gambarlah sebuah objek, gunakan freehand tool, bezier tool, pen tool, polygon tool, basic 

shapes tool atau tool yang lain untuk menggambar objek, misal kita gambar lingkaran dengan 

ellipse tool. Kemudian klik objek yang akan diberi efek kontur.  
 

  
 

 

 

 

 

 

 

 

 
2  Klik tombol Interaktive Contour Tool            kemudian klik dan tarik dari objek ke arah yang kita 

inginkan untuk membentuk kontur.  
 

 

 
 

 

 

 

 

 

 

 

 

 
3  Untuk merubah arah dan jumlah contour objek, bisa kita atur lebih detail pada window 

docker contour atau pada property bar.  
 

Keterangan opsi pada Window Docker Contour :  

 To center :   

Memberi efek kontur ke arah tengah objek. Dengan opsi ini kita  

tidak dpt menentukan jumlah kontur karena sudah otomatis  

terisi.  

 Inside :   
Memberi efek kontur ke arah dalam objek.  

 Outside :   
Memberi efek kontur ke arah luar objek.  

 Offset :  
Menentukan jarak efek kontur.  

 Steps :  
Merubah jumlah efek kontur pada objek.  

          Window Dockers Contour 
Property Bar Interactive Contour Tool 
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Keterangan opsi pada Property Bar Interactive Countour Tool :  
 

 Preset List :  
Untuk member efek kontur objek dengan pilihan yang telah disediakan oleh CorelDRAW. Klik 

drop down preset kemudian pilih efek kontur yang tersedia.  
 

 Add Preset :  
Untuk menyimpan efek kontur baru yang kita buat sendiri. Efek kontur yang disimpan akan 

masuk pada daftar pilihan Preset List.  
 

 Delete Preset :   
Untuk menghapus daftar efek kontur buatan sendiri yang telah tersimpan pada Preset List.  
 

 Object Position :   
Untuk menentukan posisi objek secara vertical atau horizontal.  

 

 Object Size :   
Untuk merubah ukuran objek secara vertical atau horizontal.  
 

 To Center, Inside, Outside :   
Untuk menentukan arah efek kontur pada objek.  
 

 Linear Contour Colors :   
Untuk mengatur warna efek efek kontur secara linear.  
 

 Clockwise Contour Colors :   
Untuk mengatur warna efek kontur searah jarum jam.  
 

 Counterclockwise Contour Colors :   
Untuk mengatur warna efek kontur berlawanan jarum jam.  
 

 Outline Color :   
Untuk mengubah warna garis efek kontur.  
 

 Fill Color :   
Untuk mengubah warna bidang atau warna isi hasil objek kontur.  

 

 Copy Contour Property :  
Mengkopi atau menyalin efek kontur pada objek kontur yang lain.  
 

 Clear Contour :  
Menghapus efek kontur pada objek. 

 

4  Atur beberapa opsi, misal : kita ganti warna objek orange (klik kiri warna orange pada 

Color Palette), ganti Fill Colour dengan warna kuning, Linear Contour Colors, dan arah 

kontur Inside. Hasilnya akan menjadi seperti berikut :  
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5 Selanjutnya, klik objek lingkaran (dengan pick tool),  

copy dan perbanyak objek menjadi 4 buah > tekan Ctrl+D untuk menduplikatkan secara cepat  

hilangkan garis tepi atau outline pada objek > klik kanan mouse pada tanda            di palet 

warna  

perkecil objek hasil copy dan atur posisinya, geser dengan pick tool   

hasil akhir objek : 
 

 

 

       Catatan :  
Apabila kita perkecil objek, maka jumlah  

step secara otomatis akan berkurang,  

sedangkan jarak contour tetap sama. 

 

 

 

 

 
6  Untuk memisahkan objek hasil kontur menjadi beberapa bagian, klik pada objek > klik kanan 

mouse > Break Contour Group Apart atau Ctrl+K pada keyboard. Kemudian klik pada 

objek lagi > klik kanan > Ungroup atau Ctrl+U pada keyboard.  
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
7  Lakukan cara yang sama pada 3 objek lingkaran yang lain. Ganti lingkaran warna kuning di 

tengah dengan warna putih. Hasilnya akan menjadi :  
 

 

 

 

 

 

 

 

 

 

 

 
Hasil akhir modifikasi objek menggunakan efek Interactive Contour Tool 
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Efek Interactive Contour Tool juga bisa diterapkan pada objek text (artistic text, bukan paragraph 

text), langkah dan caranya sama dengan penjelasan sebelumnya. Gunakan Text tool untuk membuat 

tulisan. 

 

Contoh Desain : 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

F.  PAGE CURL 
 Adalah efek gulungan kertas secara otomatis ( Page Curl ) dengan  CorelDraw 

 Langkah-langkah memberi efek page curl pada foto : 

 Buka CorelDraw anda 

 Klik Menu Bar Filen > New atau Ctrl+N 

 Klik File >  Import' atau Ctrl+I :   gambar atau foto yang akan dijadikan objek 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pilih gambar : 

 

 

 

http://1.bp.blogspot.com/_p1XqV9x05uM/TAftSphRhnI/AAAAAAAAAQI/ynQW9da-GUE/s1600/beautuful.jpg
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 Klik Menu Bar Bitmaps > 3D Effect > Page Curl : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 pada Dialog Box : Page Curl atur Direction, Paper, Color 

 

  
 

 

 

 

 

 

 

 

 

 

 

 Pada contoh ini menggunakan Color 

Page : hitam dan Curl : Putih 

Width % : 30 dan Hight % : 60 
 

 klik OK  
 

 

 

inilah hasilnya : 
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PRAKTIKUM   1 

 

MEMBUAT KARTU NAMA 

 
Membuat Kartu Nama  

 

 

 

 

 

 

 

 

Langkah-langkahnya: 

1. BukaCoreldraw - New - Buatlah kotak menggunakan Rectangle Tool dengan ukuran 9 x                            

5,5 cm ( ukuran standart kartu nama ) 

 

 

 

 

Kotak dengan ukuran 9 cm x 5,5 cm 

2.  Klik pada objek kotak menggunakan Pen Tool kemudian perhatikan properti bar diatas,Pada propertis 

Corner Roundness ganti 0 menjadi 5 yang bertujuan agar sisi pojok pada kotak agar lebih melengkung… 

 

 

Properties Pen Tool 

3.  Klik Fill Tool - Pilih Fountain Fill Dialog (menberikan warna gradient pada objek) 

 

 

 

 

Setelah itu Muncul Panel seperti berikut: 
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Pengaturan Fountain Fill 

Ganti beberapa propertis yang diberi tanda diatas :  

- Type : Gradient  

- Angle : -90  

- From : Blue  

- To : Cyan  

- Tekan tombol OK  

 

4.  Butlah persegi panjang (kotak dengan garis kuning) dengan menggunakan BEZIER TOOL            , 

Sehingga membentuk objek seperti gambar dibawah ini: 

 

 

 

 

 

 

 

 

5.  Klil Pada SHAPE TOOL              kemudian Blok Objek (1) > KLIK KANAN – TO CURVE (agar 

garis tersebut dapat dilengkungkan) 
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6.  Tarik Garis Lurus tersebut hingga melengkung sesuai dengan keinginan anda 

 

 

 

 

 

 

 

Beri warna pada objek tersebut sesuai keingginan anda kemudian... 

7.  Pilih INTERACTIVE TRANSPARENCY TOOL untuk memberikan efek transparan pada objek (1) 

 

 

 

 

8.  Klik pada Objek 1 kemudian Tarik Garis hingga membentuk transparansi objek seperti dibawah ini: 

 

 

 

 

 

 

9. Kemudian buat 2 garis Lurus menggunakan BEZIER TOOL seperti gambar dibawah dan ulang efek 

seperti langkah di atas.. 
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10.  Terakhir tambahkan Teks sesuai dengan apa yang ingin anda isikan dalam kartu nama tersebut..hingga 

menjadi kartu nama yang simpel tapi bermutu..  

  Anda bisa berimprovisasi sendiri yang lebih bagus dan  bermutu : 
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PRAKTIKUM 2 

MEMBUAT LOGO SEDERHANA 

 

Untuk praktikum ini, kita akan membuat sebuah logo sederhana. 

 

 

 

 

 

Dalam pembuatan logo sederhana ini, Anda hanya beriatih dengan menggunakan Freehand tool, 

transformasi objek (penggandaan objek. mirror, rotasi), menggunakan ellipse tool. Logo bintang dapat dibuat 

dengan Poligon tool. Untuk jelasnya,  ikuti langkah-langkah berikut. 

1.  Membuat dokumen baru. 

a. Klik File pilih New atau gunakan ikon New pada toolbar. 

b. Ubahlah ukuran kertas menjadi A4 dan satuan menjadi sentimeter untuk memudahkan pekerjaan 

Anda. 

2. Membuat tepi logo. 

Untuk membuat tepi logo, kita hanya memet\uka.n free hand tool, kemudian hasilnya digandakan dan 

ditransformasi sedemikian rupa sehingga membentuk tepi logo,  

a. Buat sebuah garis menggunakan freehand tool. 

 

 

b. Klik Shape tool, klik titik sebelan kanan.  

 

 

c. Klik Convert Line to Curve.  

 

 

d. Ubah garis menjadi kurva berikut.  

 

e. Klik dengan Pick tool, kemudian gandakan. Tekan Ctrl + C kemudian cerminkan secara horizontal 

dengan tombol mirror       

f. Geser hasil penggandaan yang telah dicerminkan sehingga membentuk gambar berikut. 
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g. Dengan menggunakan Pick tool, drag daerah yang melingkupi kurva tersebut sehingga seluruh 

kurva terpilih 

 

 
 

h. Klik kanan objek kemudian piiih Group. Klik objek tersebut kemudian gandakan. Caranya,klik 

 objek, tekan Ctrl + C, kemudian Ctrl + V. Anda juga bisa menggunakan ikon           dan  

 

 

 

 

 

i. Karena tepi logo nanti berbentuk segi lima, rotasikan hasil penggandaan sebesar 72°.  
j. Geser sehingga membentuk bangun berikut. 

 

 

 
 

k. Gandakan lagi dengan menekan Ctrl + V, kemudian rotasikan hasil penggandaan dengan sudut 

berturut-turut adalah 144°, -144°, -72° dan atur sedemikian rupa sehingga akhirnya terbentuk gambar 

berikut. 

 

 

 

 

l. Grup semua objek dengan Ctrl + G. 

m. Gandakan objek sehingga hasil penggandaan beriimpit. 

n. Ubahlah ukuran hasil penggandaan dengan cara menekan Shift, tanpa dilepas, drag titik pada kanan 

bawah objek ke arah dalam.   
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o. Grub lagi hasilnya. 

Sebelum melangkah lebih lanjut, simpan pekerjaan Anda. 

Caranya klik File, pilih Save As, beri namafile Prakt Logol 

 
3.  Menambah tulisan, 

Dari logo di atas, terdapat dua tulisan, salah satunya melingkar. Salah satu kelebihan dari Corel Draw 

adalah Anda dapat membuat tulisan melewali suatu lintasan tertentu. Lintasan ini dapat berupa kurva 

atau objek, seperti lingkaran, persegi panjang, atau objek lainnya. Sebagai contoh, perhatikan langkah-

langkah berikut. 

a. Dari pekerjaan Anda sebelumnya, buat sebuah lingkaran tepat di tengah-tengah. 

b. Klik Text tool. 

 

 

 

 

 

c. Letakkan kursor tepat di atas lingkaran sehingga kursor berubah menjadi IA . 

d. Tuliskan "SEKOLAH MENENGAH BINTANG MAS'" sehingga tepat mengikuti kurva pada 

lingkaran. (Anda dapat mengganti tulisan Anda sesuai dengan nama sekolah Anda). 

 

 

 

 

 
 

e. Tambahkan tulisan yang berposisi mendatar. 

 

 

 

 

 

a. Klik lingkaran dengan Pick tool , kemudian Delete. 
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4.  Menambah logo bintang. 
Untuk logo, Anda dapat mencari gambar kemudian diimpor. Akan tetapi, untuk contoh yang sederhana 

ini kita bisa dapatkan dengan menggunakan Poligon tool. 

 

 

 

 

 

 

Ubah ukuran logo bintang dan posisikan sehingga menjadi tepat. 

 

 

 

 

 

 

Simpan hasil akhir pekerjaan Anda. Dari praktikum logo sederhana ini, dapat Anda kembangkan untuk 

membuat desain-desain seperti logo dan stempel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Panduan praktikum CorelDraw X3 2011 
 

   36 

tiksman8kediri--------------------------------------------------------------------------------------------- susmix24.co.cc         

 

 

 

PRAKTIKUM 3 

MEMBUAT KARTU IDENTITAS 

 

Pada bab sebelumnya Anda sudah belajar membuat 

logo dari sebuah sekolah tinggi. Sebelum melangkah lebih 

lanjut, yang perlu Anda siapkan adalah sebuah logo (bisa 

menggunakan logo yang Anda buat sebelumnya) dan file 

foto. Anda akan membuat kartu identitas, misalkan kartu 

perpustakaan. 

Untuk membuat kartu identitas, ikuti langkah-langkah 

berikut. 

 

1.  Membuat dokumen baru 

 a.   Klik menu File kemudian klik New. 

 b.   Tentukan ukuran kertas A4 dan satuannya adalah cm.  

2. Menentukan ukuran kartu 

 a.   Hal pertama yang harus dilakukan adalah menentukan ukuran kartu. Buatlah sebuah persegi panjang  

dengan ukuran, misalkan 8,5 cm x 5,5 cm. 

 b. Jika tampilan normal, tentu saja ukuran kartu nama itu sangat kecil untuk membuat detailnya. Oleh karena 

itu, zoom tampilan dengan menggunakan Zoom Tool dan pilih Zoom Tool for All Object              pada 

property bar. 

 c. Untuk membuat bagian footer, gandakan persegi panjang dengan Ctrl + C dan Ctrl + V sehingga hasil 

penggandaan akan berhimpit dengan objek yang asli. 

 

 

 

 

 

 

 

d.  Ubahlah ukuran lebar hasil penggandaan. 

e.  Pilihlah persegi panjang yang lebih kecil dan beri warna dasar hitam. Masih ingat. kan 

caranya? 

f. Pilihlah persegi panjang yang besar, kemudian berilah warna dasar putih. 
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3. Membuat header 

a.  Impor file logo yang pernah Anda buat. 

 Caranya: 

 Klik File. 

 Pilih Import. 

 Pilih folder dan nama file. 

 Letakkan pada pojok kiri atas. 

 Ubahlah ukurannya sehingga sesuai dengan ukuran kartu. 

 

 

 

 

 

 

 

b. Klik Text tool, drag di scbelah kanan logo. 
c. Tambahkan header kartu. Aturlah jenis font dan ukuran sedemikian rupa sehingga seperti contoh 

berikut. 
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d. Tambahkan garis menggunakan freehand tool. 

 

 

 

 

 

 

 

4. Mengimpor foto 
 Klik File , pilih Import. 

 Pilih folder dan nama file foto yang akan dimasukkan. 

 Ubah ukuran dari posisi foto. 

 

 

 

 

 

 

5. Menambahkan identitas dan folder. 

a. Klik Teks tool , drag di sebelah kanan foto. 

b. Ketikan identitas pada area seperti berikut. 
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c. Gunakan tombol Tab pada keyboard untuk merapikan tanda Anda juga bisa menggunakan 

ruler di bagian atas seperti dalam Microsoft Word. 

 

 

d. Klik Teks tool , kemudian drag pada bagian footer. Pilih warna font putih dengan Color 

Pallete. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Panduan praktikum CorelDraw X3 2011 
 

   40 

tiksman8kediri--------------------------------------------------------------------------------------------- susmix24.co.cc         

 

 

 

PRAKTIKUM 4 

MEMBUAT LOGO IDOSIAR 

 

 

 

 

 

 

 

 

 

Langkah-langkahnya : 

 

1.  Sepertri biasa buat file baru Ctrl+N 

      lalu membuat sebuah lingkaran menggunakan Ellipse Tool atau tekan F7 usahakan sambil      menekan 

Ctrl+Shift supaya bentuknya proposional, di sini sengaja tidak menyebutkan patokan  ukuran – 

ukurannya, Anda bisa memberikan ukuran pada masing – masing objek yang lebih sesuai  lagi dengan 

hati Anda  

2.   Buat persegi panjang dengan menggunakan Rectangle Tool (F6) dan timpakan di lingkaran yang telah 

kita buat tadi, atur letaknya seperti pada gambar di bawah ini : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.  Tekan Ctrl A pada keyboard untuk menyeleksi semua objek kemudian Trim               pada   Menu Bar 

klik Arange > Shaping> Trim 

Setelah ditrim kamudian hapus persegi panjangnya seperti pada gambar di bawah ini : 
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  Maka hasilnya :  

 

 

 
 

4.  Buat lagi persegi panjang tipis  seperti kira – kira pada gambar di bawah, kemudian   lakukan 

trim seperti pada langkah sebelumnya.  

 

 

 

 

Setelah ditrim dan dihapus / delete / ditiadakan / dimusnahkan  persegi panjangnya maka nanti 

hasilnya seperti di bawah ini : 

 

 
 

5.  Kemudian klik kanan pilihBreak Curve Apart ( Ctrl K ) untuk memisahkan masing – masing 

objek hasil trim / potongan tadi yang masih menyatu, hal ini dilakukan untuk mempermudah 

pewarnaannya nanti. 

6.  Sekarang kita duplikat objeknya lakukan Transformations pada Menu Bar klik Arange > 

Transformation> Posision ( Alt + F7 ), jika kotak dialog Transformations sudah muncul di 

sebelah kanan pada layar monitor Anda, mari kita klik langkah – langkah seperti yang dilingkari 

di bawah ini : 
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7.  Kemudian  posisikan sehingga menjadi seperti ini : 

 

 

 

 

 
 

8.  Sekarang kita beri warna masing masing objek seperti di bawah ini : 

 

 

 

 

 
 

Anda bisa mewarnai semirip mungkin dengan yang aslinya,  

9.  Setelah memberikan pewarnaan seperti di atas sekarang kita tambahkan Teks Indosiarnya, saya 

menggunakan Century Gothic Bold, dan yang huruf O nya itu kita bisa membuatnya sendiri 

dengan 3 lingkaran merah. kemudian atur ukuran dan posisikan seperti pada gambar di bawah. 

 

 

 

 

 

10.  Sekarang kita hilangkan Outline-nya. Caranya Ctrl A untuk memblok seluruh objek klik Fly 

Over Outlinen-nya pilih None :  
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11.  Buat persegi panjang lagi dan atur letaknya supaya mengelilingi semua objek yang telah kita 

buat tadi, lalu gunakan Shape Tool untuk menumpulkan siku  persegi panjangnya drag salah 

satu node yang terletak di pojok persegi panjangnya atur arahnya . Ilustrasinya Anda bisa 

melihat gambar di bawah : 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hasil akhirnya akan terlihat seperti disamping:  
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PRAKTIKUM 5 

MEMBUAT LOGO TELOMSEL 

  

 

 

 

 

 

 

 

Langkah-langkahnya : 

 

1. Jalankan Program CorelDraw, nah buatlah sebuah objek segienam, Pilih polygonal tool, kemudian pada 

property bar, Anda masukkan nilai 6 untuk membuat segienam 

 

 

 

 

 

 

 

 

 

2.  Miringkan objek segienam tersebut dengan merotasikannya sebesar 350 derajat 

 

 

 

 

 

 

3. Warnai objek tersebut dengan warna abu-abu (gray) dan copy satu objek lagi  

beri warna merah, posisikan seperti berikut, hilangkan line dari objek tersebut. 
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4. Nah sekarang kita akan membuat bentuk lingkaran yang melingkup objek segi enam tersebut, 

gunakan ellipse tool buat agak melonjong horizontal.  

Kemudian Anda copy-kan objek elips tersebut tapi kecilkan sedikit letakkan di atas objek elips 

yang pertama seperti berikut : 
 

 

 

 

 

 

 

5. Beri warna abu-abu terang (30% black) pada objek elips yang terpotong, letakkan pada 

objek segienam, gandakan objek elips yang terpotong tersebut atur posisi sebagai berikut : 

 

 

 

 

 

 

 

 

 

6. Sekarang kita akan membuat perpotongan antara objek elips yang terpotong dengan segienam merah,  

klik objek segienam merah tekan Shift kemudian klik salah satu objek elips yang terpotong, 

pilih metode intersect pada property bar, beri warna putih pada hasil pemotongan,  

lakukan hal yang sama pada objek elips yang terpotong lainnya dengan segienam merah. 
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7.  Ketikkan teks TELKOMSEL (Arial, Bold, Italic) di sebelah kanan logonya.  

 

Hasilnya seprti dibawah 

 

 

 

 

 

 

 

PRAKTIKUM 6 

PRAKTIKUM BEBAS 

6 a. Membuat Brosur 

6 b. Membuat Pamflet 

6 c. Iklan 

6 d.  Stempel 

6 e. dll. 

 

 

 


